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Section 1 - Introduction

What is CDS G3?

CDS G3 is a standalone PC-based program that complements the original Mercury Computer Diagnostic System (CDS) by
providing diagnostic support for select engines and Mercury Joystick Piloting systems. Additionally, all configuration functions
necessary for preparing these systems for delivery are supported. CDS G3 allows for CAN-based multiple-processor
communication through a clean, easy-to-navigate interface.

CDS G3 Support

Mercury Marine will provide support for the CDS G3 program and hardware. Any issues determined to be outside of the CDS
G3 program or hardware will be the responsibility of the user. For support with CDS G3, contact Mercury Marine Technical
Service at 920-929-5884.

Installation

Any new installation of CDS G3 may be installed without a previous version of the software installed. Before proceeding with
installation, complete all High Priority Updates as provided by Microsoft through Windows Update.

If updating CDS G3 from version 1.0, uninstall the software prior to installing the current version. If updating from CDS G3
version 1.1 or later, uninstallation is not required.

To install CDS G3, double-click the executable (.exe) that you downloaded from the service.mercurymarine.com website.
During installation, the following programs may be installed:

*  Microsoft® ReportViewer 2010

*  Microsoft Visual C++ 2010 SP1 Redistributable Package (x86)
*  Microsoft .NET Framework 4.5.2 Web

*  Windows Installer 4.5

*  Kvaser® 4.9 CAN Adapter Driver

These additional programs are required for CDS G3 to deliver a rich, interactive user experience.
When the Literature feature is installed, the following applications and libraries may also be installed:
* IS Express 8.0

*  Microsoft .NET Framework 4.5.1

*  Microsoft Internet Explorer 11

Administrative Rights

The user performing the CDS G3 program installation must have administrative rights. If the computer has an MCDS user
account, that user account was given administrative rights when it was created by an earlier CDS installation.

NOTE: Some information technology (IT) departments may restrict user rights for these accounts. If this has occurred, either
the IT department must perform the installation, or they must grant administrative rights to the user accounts performing the
installation.

Computer Requirements

The following specifications are established to support both CDS and CDS G3. Minimum and recommended specifications are
listed below. Please adhere to the minimum specifications when upgrading CDS G3 on an existing computer. The
recommended specifications have been established to provide a guideline for both best experiences and what we suggest
when purchasing a new computer.

PC Minimum Hardware Specifications
* 1.2 GHz multi-core processor (two cores or more)
* 1024 x 768 screen resolution
* 10.1in. screen size
+ 2GBRAM
120 GB hard drive
+ 802.11 b/g/n wireless or 10/100 Ethernet
+ DVD ROM optical drive (an external USB DVD drive is acceptable)

*  Three USB 2.0 or 3.0 ports to accommodate CDS USB components. Alternatively, a single USB port and a USB port hub
may be used.

«  Optional 9-pin serial port (The serial port is no longer required, but is still preferred. The use for a serial port is for CDS
only.)
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Section 1 - Introduction

Recommended Computer Specifications (Where Different from Above)

. Intel® 15 processor, 2.4 GHz or higher
+ 8GBRAM

+ 128 GB solid-state drive

+ 802.11n+ wireless connection

Operating System Requirements

Microsoft Windows® 7 Professional with Service Pack 1, Windows® 8.1 Professional, and Windows® 10 Pro are the only
operating systems that have been tested to work with the CDS G3 product. For best performance, Windows® 10 Pro is strongly
recommended. CDS G3 1.7 and greater versions will not support and will not operate on Windows® XP Professional or
Windows® 8 Professional.
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Notes:
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Section 2 - Licensing and Registration

License and License Key Explanations

License: A license enables a Microsoft Windows® PC (see Operating System Requirements for details) to operate the CDS G3
Software during the support period (typically two years from the release date). One license is required for each PC that needs
to operate the CDS G3 product.

License Key: A license key is a 25-character alphanumeric key (for example X1X1X-X2X2X-X3X3X-X4X4X-X5X5X) that is
used to unlock the CDS G3 application and that ties a PC to a license. One license key will be issued for each license that is
purchased. The key is purchased from Mercury Marine and will be shipped to the dealer on the license key card:

MERCURY

/ Computer Diagrostic System G3

gl 7S

Y
X2-3X3X3-4X4X4-5X5XS

60996

NOTE: A CDS G3 license can be removed from a machine by pressing the "Deactivate Machine" button from the Help->About
menu. This will free up a license and allow the license key fo be reused on a new or different PC. This option is only available
when a license is active.

The CDS G3 License

Mercury Marine is the provider of the CDS G3 license, which permits the purchaser to access diagnostic content, configuration
tools, and features via the CDS G3 product for business use only. Licenses and license keys are NOT transferable. Hardware
is not provided with the purchase of a license and must be purchased separately.

The CDS G3 licensing agreement is presented for review and acceptance during installation. This document can also be
accessed after installation in the start menu. The location is: Start->Mercury Marine->End User License Agreement.

Review this document for further details.

License Activation

Version 1.7 no longer offers the trial option to use the software before it's activated. When a CDS G3 license has been
activated, account revalidation is still required every 45 days. CDS G3 may only be used by contracted Mercury Marine
accounts, so the 45-day revalidation requirement is partially intended to ensure that only active accounts may use the software.
The other purpose for revalidation is to ensure the software stays up to date. To license and validate CDS G3, internet access
is required. The software installation may be revalidated at any time to restart the 45-day validation period. If the PC is
connected to the internet when CDS G3 is started, revalidation will automatically occur. Manual revalidation can be done from
the Help->About window by pressing the Validate Account button. Once the 45-day validation period has expired, the software
will be disabled until revalidation is completed. If the 45-day validation expires in error, revalidation requirement may be
extended for five (5) days to get the current job completed. However, by the end of the 5-day extension, account revalidation
must occur before the software will work again.
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Section 2 - Licensing and Registration

When the CDS G3 software is started for the first time, the
license activation screen will launch and will prompt the

user for a dealer number and the 25-character license key
that was purchased from Mercury Marine.

Help

License Activation

This software has NOT been activated.

To activate this product, please enter your complete
account (dealer) number and the license key that you
purchased from Mercury Marine.

Q EXIT

B ssmesses

Enter the dealer number and license key. Click "Activate."

g _t=2eg82’t

Once you click on "Activate," the following screens will
appear:

(%]
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To activate this product, please enter your complete
account (dealer) number and the license key that you
purchased from Mercury Marine.

Elle Tools Help

License Activation

This software has NOT been activated.

To activate this product, please enter your complet;
account (dealer) number and the license key that
purchased from Mercury Marine.

Q exir

Blle Tools Help

License Activation

This software has NOT been activated.

License Information

1234567

License Information

Account number

License key

Format: J000(-X0000(- X000 - 00006 K000

This software is not
—
flle  Tools

ACTI

60497

ACADY-SC4HQ-6J IRXVLGEWV—DA9471

Format: XX000(-X0000K- X0000(- X000 X0

[ s e i i i i, -2
==

License Information

1234567

ACTIVATE Q@

60498

EXIT

ACADY-SC4HQ-6JHRX-LGBWV-DA%47

Format: J000(-X000XK- X000 -X000C- K00

Connecting to Mercury Servers...
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Mercury €D G3 - iccount revalidation is required by 1/14/2016.

File Tools Help

License Activation

This software has NOT been activated. License Information
To activate this product, please enter your complete {
account (dealer) number and th

purchased from Mercury Maring

1234567

SUCCESS! DA947

Your software license has been activated and your
account has been validated.

You have 45 days left before revalidation is required.

ok O

Q T

60500

CDS G3 Version Number

CDS G3 versions are defined by a version number. The example below shows version 1.7.0. The version number will define

three parts of the version: a major version, a minor version, and a build number. The image below is from the CDS G3 startup
splash screen, along with a description of the version number.

{

MERCURY

Computer Diagnostic System G3

version: 1.7.0

60501

Page 8
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The complete version number can be noted from the splash screen, as shown above, or by selecting Help->About from the
menu at the top of the screen. The following screen will display.

-

Computer Duagnestic System G3

Computer Diagnostic System G3

YWers

jion 1.7.2

b Liberature Viewer is not installsd

This software has been activ

Acoount numibser :
name :

address

abed on this machine with the following

1234587
MERCURY MARIMNE - DEMOMNSTRATION
WELSD PIONEER RDAD

rense information

city : FOND DU LAC
state : WI
zip: S403E
Account vakdated through : 3/27/2016
Tovalidate account ©  iplidade Account
Computer nams : MMPDLLOL511
Licerse wey - ACADY.SCAHG-6JHRN-LGBWV-DASLT

T reuse this BCEnse | Dipactivate Machine

Copynight © 2016 Mencury Manine

60950

The major version number will designate drastic changes to the software.

This number has not changed since the introduction of the CDS G3 software. The minor version number designates
considerable changes in the software, usually requiring the release a new executable. Typically this update will introduce new
functionality and address major issues.

The build release number designates small changes in the software. Typically this includes new eBOM’s (electronic bill of
material), minor bug fixes, and provide slight product improvements. These updates are downloaded from within the CDS G3
program.

CDS G3 Updates

Only build releases are provided at no charge during the active support period. Mercury Marine will make every effort possible
to make each of these releases available directly through the CDS G3 application from the Home screen. As long as the
computer has internet access when the CDS G3 software is started, it will automatically check for available updates. When
updates are available, there will be a notification on the Home screen or on a pop-up at the bottom of the screen. The update
process can also be manually initiated by selecting "Check for Updates" from the gear menu on the Home screen. In the event
that updates cannot be provided directly from CDS G3, they will be made available through the service.mercurymarine.com
website. When an executable (.exe) is provided as an update, it will contain everything needed to install and run the software.
There is no need to have a previous version of the software installed. Also, if a previous version is installed, an executable
update can be installed without uninstalling the previous version.

The CDS G3 kit no longer includes an installation disc; it will only contain the hardware required to use the software and a
license key. If you don't have a high-speed internet connection available to download the executable in an acceptable amount
of time, a backup disc which contains the latest installation of CDS G3 is available for purchase. The purchase of a backup disc
does not include a license to use the software.

90-8M0117619 eng FEBRUARY 2016
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Notes:
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Section 3 - Hardware

Requirements
CDS G3 requires the following hardware:

898289T81—SmartCraft interface cable (USB to DB9) (contains
879365022)

898289T83—CAN P and H adapter (DB9 to 10-pin
CAN) (contains 8M0044023)

This harness functions only as an adapter between a DB9 and
SmartCraft CAN connector

a- CAN adapter cable

b - Connects to SmartCraft interface cable DB9

¢ - Connects to engine or J-box CAN connector

8M0046081—Harness adapter w/resistors (10-pin
CAN to 10-pin CAN)

E NG
Iy |: m _ E‘h TE
57232

Required to replace a termination resistor when one is removed to
gain access to the CAN bus

a- Engine connection (note the Engine tag)

b - Termination resistor end (note yellow tag)

All of the components above are included in the CDS G3 kit, part number 8M0114141. When interfacing the CDS G3 diagnostic
tool to the CAN bus, proper termination must be maintained. If the CAN bus is being accessed by removing a termination
resistor, the 8M0046081 adapter harness must be used. If the CAN bus is being accessed through an open J-box port,
8M0046081 will not be used. More details on proper connection are detailed in the section, CDS G3 Harness Connections.
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SmartCraft Interface Cable

The SmartCraft interface cable is a diagnostic interface to provide the ability for CDS G3 to communicate on Mercury CAN bus
networks. Some features of the SmartCraft interface cable are:

1. Ruggedized

2. 2 channel (CAN P/H)

3. USB-to-DB9 interface

4. Powered from the PC, not the engine

The SmartCraft interface cable has three LED lights: one green power LED and two orange CAN bus LEDs.

The power LED will illuminate solid green to indicate it is functioning correctly. This LED will flash if it has an issue. If this is
encountered, most likely the device driver is not installed properly. Corrective action for this condition is documented in the
Appendix.

When the SmartCraft interface is properly connected to both an engine and the diagnostic computer, there will be a solid
orange LED on the appropriate BUS indicator on the interface (BUS 1 and/or BUS 2). This LED will flicker with communication.
Any noncommunicating BUS channels will be indicated with an occasional illumination of the associated orange LED. Similarly,
the CAN P/CAN H button in the CDS G3 software would be red or yellow to indicate no communication and green to indicate
communication.

CDS G3 Harness Connections

Vessels with a Junction Box
1. Insert the SmartCraft Diagnostic Interface USB connector into a powered USB port.
2. Connect the SmartCraft Diagnostic Interface DB9 connector to the CAN P/CAN H adapter harness DB9 connector.

3. Connect the CAN P/CAN H adapter harness to the junction box to communicate with the power package.
IMPORTANT: Ensure that the correct termination resistor is installed on the CAN P bus. The CAN P bus must be properly
terminated for the tool to communicate reliably. Improper termination will result in communication errors or complete loss of
communication.

a- SmartCraft interface cable

b - CAN P and H adapter

¢ - Harness adapter with resistor

d - Connect to engine or J-box connection

e - Connect to key f of CAN P and H adapter
f- Connectstoe

g- Connectsto h

h- Connectsto g

i- Connects to computer USB port

90-8M0117619 eng FEBRUARY 2016 Page 13
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57235

Junction box connection

Vessels without a Junction Box
1. Insert the SmartCraft Diagnostic Interface USB connector into a powered USB port.
2. Connect the SmartCraft Diagnostic Interface DB9 connector to the CAN P/CAN H adapter harness DB9 connector.
3. Remove the CAN P termination resistor from the engine harness.
IMPORTANT: Ensure that the correct termination resistor is installed on the CAN P bus. The CAN P bus must be properly

terminated for the tool to communicate reliably. Improper termination will result in communication errors or complete loss of
communication.

4. Connect the CDS G3 harness adapter (84-8M0046081) to the CAN P/CAN H adapter harness, and connect the adapter
harness to the engine harness connector.

CDS G3 typical engine connection (4.5L shown)

IMPORTANT: The CDS G3 harness adapter (84-8M0046081) contains the correct termination resistor for the SmartCraft
Diagnostic Interface to communicate with the control module.
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New Features Introduced in CDS G3 1.7.0

With the release of CDS G3 1.7, Mercury Marine is excited to introduce two new features, multi-module support and account

revalidation emergency extension.

Live Data View—Multiple Modules

The live data view—multiple module feature was developed to help in multiple engine applications when one engine is running

abnormally and the other engines are running normally.

60503

17 Mercury CDS G3 - Account revalidation is required by 1/15/2016. =)
I I I :
E| Tools Help Outboard - %Dmg LEG14p0AAAD V1 b as 1 Engines 4 a- Module or engme check bOXGS
Mudule Data - M
b - Systems data tab
b BOATLOAD FIPORT I PORTINNER [ STARBOARDINNER  [F] STARBOARD m‘ﬂ
|} SENSOR NAME PORT PORT INNER | STARBOARD INNER | STARBOARD | DESCRIPTIC
RpmFilt w0 r/min 0 r/min 0 r/min 0 r/min Engine speed I
DemandLinear @ 0.00% 0.00 % 0.00 % 0.00 % Demand requ
‘ TPSPercent i 0.00 % 0.00 % 0.00 % 0.00 % Throttle positi
I
BaroPress i 15.229psi  15.229 psi 15.229 psi 15.229 psi Barometric pn
ManifoldPress wlk 36.114psi | 36.114 psi 36.114 psi 36.114 psi Manifold pres:
ChargeTemp Wl 32°F 32°F 32°F 32°F Intake air tem|
LoadPercent Wl 100.00%  100.00% 100.00 % 100.00 % Engine load
FPCTotal W 188.33mg 188.33mg 188.33 mg 188.33 mg Fuel per cylinc
BoostCtriDutyCycle s 93.99 % 93.99 % 93.99 % 93.99% Boost control
QilPressure ik 95.0 psi 95.0 psi 95.0 psi 95.0 psi Oil pressure
CintTemp i 32°F 32°F 32 °F 32°F Engine coolan
@ RECORD | JIPAUSE
P f o5 g &8 @ 5 &
m MODULE DATA. CONFIGURATION DIAGNOSTICS REFLASH UTERATURE

To use this feature, go to the Module Data screen and select the System Data button at the top. Then, select the desired

modules or engines to compare.

5-Day Account Validation Extension

The 5-day account validation extension feature has been added to address those situations where CDS G3 users have
forgotten to revalidate the software before the 45 day revalidation period has expired. Selecting the "Extend 5 Days" button will
allow fully functional use of the CDS G3 without revalidation or connecting to the internet for five additional days. This feature
will be especially useful for the technician that has traveled offsite to a customer's boat, only to discover upon arrival that the
CDS G3 program needs revalidation. Instead of spending precious time searching for an internet connection, the technician
can immediately get to work on the boat and perform the revalidation after returning to the shop.

! License must be vaiiated (= e
file  Tools Help

License Validation

Error 112: Online validation has failed. License Information

Please connect to the internet and click Validate Account number 1234567

below. License key ACADY-SC4HQ-6JHRX-LGBWV-DA947

9 EXIT EXTEND 5 DAYS Q VALIDATE ©

60504

License validation "Extend 5 Days"

Page 16
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Section 4 - New Features

CDS G3 1.7 has a big change because the entire licensing and revalidation process was rewritten, all of which benefit the
dealer from a time perspective and help make customers happy more quickly. The 5 day extension is one important piece of
the licensing change.
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Notes:
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Section 5 - Becoming Familiar with the CDS G3 Program

Home Screen

The Home screen will report important information,
including issues requiring attention. The screen capture to
the right, is displaying notifications of a new software
update, the SmartCraft interface cable is not detected, and
no eBOM is selected. These issues should all be
addressed for CDS G3 to function properly.

£ Mercury DS G3 - Account revaiidation is required by 1/14/2016.

License Activation Screen

The License Activation screen will be presented on any
CDS G3 installation that has not been activated. This
screen is also displayed when the 45 day revalidation
period expires. To activate a license, an internet
connection is required. The full dealer number and the
25-character license activation key are required. Account
revalidation is required every 45 days, but is performed
automatically when an internet connection is present
during the application startup. It can also be performed
manually at any time.

Once completed, the 45-day registration period is reset.

|
|

Elle  Tools Help

(= | O
Flle Tools Help
T T P )
1 @ There is a new version of G3 available (v1.7.3) UPDATE Q
2 0 SmartCraft interface cable not detected
3 o No eBOM is selected RESOLVE ©
ENGINE INFORMATION A
Active Faults
s A o8 @ fo@
| mo | e L S0 L |
60506

|4 This software s not license

License Activation

This software has NOT been activated. License Information
To activate this product, please enter your complet,
account (dealer) number and the license key that
purchased from Mercury Marine.

1234567

ACADY-SC4HQ-6JHRX-LGBWV-DA947|

Format: JOO0OK-XX00K - XOCEXX - KI0UEX X000

ACTIVATE ©

Page 20
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Section 5 - Becoming Familiar with the CDS G3 Program

CAN Traffic

The CAN button will let you know the communication
status on CAN P and CAN H.

*  Red—The computer is not connected to the
SmartCraft Diagnostic Interface cable

*  Yellow—The computer is communicating with the
cable but no data is being received on the CAN bus.

*  Green—The computer is communicating on the CAN
bus.

NOTE: CAN H will only turn green for models using CAN H.

(Example: Outboard Joystick Piloting and Axius products)

Module Data Screen

The Module Data screen allows the user to view data and
engine faults. The selections in Module Data include:

* Play Data: Allows the user to open a recorded file
(.bdr) from a previously recorded session and play
back the data in raw format.

* Record Data: Allows the user to choose data items
and record them to a file (.bdr).

NOTE: Only numerical items may be recorded at this time;
this may not represent all of the ifems available via live
data.

. Live Data: Provides access to the data items for all
modules.

+  System Data: Provides the ability to view data at
system levels, and to compare data between multiple
modules in that system.

*  View Faults: This button is only available if faults are
found on the engine. The red text in the info column
indicates that the engine has faults.

*  Freeze Frame: Provides access to memory buffers
within the ECM. Freeze Frame buffers contain
snapshots of data items at the time a fault occurs.

* Run History: Provides access to a runtime history
map. Each time value is assigned to an RPM band.
The RPM bands can be cleared but the total engine
runtime will stay the same.

* Maintenance: Displays the current maintenance
value, and provides access to resetting the
maintenance percentage to 100%.

* Reload Modules: Clears all modules in module data
and restarts module discovery.

*  Clear All Module Faults: Clears all faults present
and rescans for faults.

]
€ EXIT

el
H

57018

- nmm

3 i - R T g 1AL
Ml Toch g [

¢ = Warmdn - LFG120044A7 - Helme 1 Ergines

A Mudule Data

wiew Facks W Frecce frame J o histos

LML LARXN AL K, IR 2

ok ETED TV Y TV IO PAND B d_MIPCE POL_30

PRI Freine LETILS I
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Printing

A newer feature in CDS G3, introduced in version
1.5, is the ability to print data from Freeze Frame,
Faults, and Run History. This feature provides
the ability to create a clean, professional document
in printed form, or a PDF document. Each of these
screens will have a gear icon in the upper right
corner to access the Print Page feature. This icon
will not be available from View Faults or Freeze
Frame if faults or freeze frame data are not
present.

Another new print feature is the ability to create a

- o EN
full report. A full report will create a summary view,

and include freeze frame, faults, and run history,

along with the ability to include your full dealership

information and your customer’s information.

A full report can be created by selecting

File->Print Full Report, or pressing F12. Inside

the preview of a full report, a gear icon will be

available to include or exclude dealer and

customer information.

The customer’s information can be added directly

into this menu when Add Customer Information

is selected. This information will be available until

the CDS G3 program is closed,; it will then be

removed. You may change this information at any RESOLVE o
time without closing the software by selecting the

gear icon, Remove Customer Information, and

again select the gear icon and Add Customer 57021
Information. The Add Customer Information

window will open and allow you to change the

content. .
Dealer information is downloaded from the Gear icon
Mercury Marine servers and is not currently

editable.

With the inclusion of these new print features, the

Print Screen button in the main tool bar has been

removed. You can still use the old print screen

function by either selecting File->Print Screen, or

pressing Ctrl+F12 to capture the current screen.

Live Data—Categories and Drag and Drop Sorting

The live data screen has undergone considerable changes intended to improve readability and ease of use. Along with
improvements to the layout, all data items may be reordered by simply dragging and dropping the item in the desired location.
This will allow you to bring focus to items of concern within the same view without having to scroll to view data items.

While working with some systems, the live data screen may now show two tabs. These tabs are categorized data list items:
Engine and Catalyst. Data items specific to catalyst have been located in the catalyst category. When diagnosing a catalyst
related issue, selecting the catalyst category will provide you with quick access to this data without having to filter through the
full data list.

Graphing

The Graphing feature is integrated into the Live Data section inside Module Data. When in Live Data, graphing can be
initiated by selecting up to eight items by simply clicking on the box to the left of the item. The chosen items will then turn green
and display a check in the box. As each is selected, the graphing tab will display the quantity of items chosen. Next, select the
Graph tab. This will open the graphing interface and start to plot and graph the items previously selected.

While using the graphing feature, there are several controls to enhance use. On the right side of each graph is a tab, which will
expand that specific graph to a full screen view. While in this full screen view, the additional controls will be available.
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The triangles to the right can be dragged up and down to define upper and lower limits. Also on the left are + and - buttons to
zoom in and out. The focus point of zoom is the middle of the graph. It is best practice to pan the graph to the desired area
before zooming. Above and below the zoom controls are up and down buttons to pan the chart. By selecting the shrink button
in the lower right, the view will return to the previous screen, keeping the settings just made.

The gear icon in the graphing display will provide more shading options for the graph, along with logging customer information
and resetting the graphs to their default settings. By providing customer information, any recordings can be saved with this
information preentered as the file name. At any time, while in either Live Data or Graphing, recording data can be initiated by
clicking on the record button in the lower left. After a recording is made and saved, all the data is available to be replayed either
in a data view or graphing view for further analysis.

B i Regnand a4l depl 1L
M Teel e Tamirg - Dutboard - 4 Oyinder - TrafDinpARS - Fn

Graphing screen example

Gear Icon and More Options

As shown previously, there is now a gear icon on select screens. By clicking on this gear icon, more options for the specific
feature will be shown.
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eBOM

The eBOM (electronic bill of materials) screen displays the ", . . — .
possible matches to the system the tool is connected to.
CDS G3 has the ability to actually talk to each ECM/PCM  [Elzes L L L -

that is connected in the boat via CAN P. It will report what ?L'T“""!' N ":‘"I'mr“m
ECM/PCM it has found by showing a match next to those T IS A
particular eBOMs. Some boats can have multiple ECM/

- RRF P I
X . . e e = ECT 6 Cplind e Alpha = DR 4 7 AL

PCM's depending on the SmartCraft configuration and the [ suswrv. -7 6 cstnetr i - pra=s 2o
. 2 Semintiins - 717 A€l Al - WOTRARE

number of engines. 5 stemdnve - 1% i - WY IOEEAGE

El"'J Stemmhiive - ST 4 Cylincder 8lphe - frDGAaNG

5 Savmmmliin: - 574 Cinndir 8l - HED98AC

|7 Stemdnive - COT 4 Eptincer Blpha - MYDuGA
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| Sl FCT AR TRAAR

= Stem - EC7 4 Clinder Ares - ARF M PY ARG
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=) Saemmmliive: - E0T Alpha - WTEAAR

.lEl\mMr we FET Alpha SINDRAT

;*.’:.'Hrmdl we - ol Ll er Aiuz A - RTINS

0 Svmmliivg - E57 6 iy Avius 43 - BREM_MY ALY
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57025
The eBOM Selection Helper has been implemented to }.. — — .

assist the user when CDS G3 cannot resolve the selection
of an eBOM. &S0M Sakaction Halpar

Turm all ey s
Thocese ther s BOM thatt matchees wour sysor by peessing SELECT,

o OUESTIN:
e b | s il b e U w0 | Thane s sl el sitiasn?

(2, DUCSTION:
ity de- | e v cebecman 2O

7 ETIOR;
Heow do | sbow allsbOds "
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Configuration

Configuration allows the user to access the helm-related _ ST i B 1o =

M Tl g

configuration items, such as steering wheel, handles, and [FEErEEEE =
CAN pads.

R —
lisim Cantiguraticn !

CAN Pad cnnﬂ:ulra Gl

Lk i e ed fa 4 il 1L - " N

Helm Configuration provides access to helm status and ' . .
configuration tools required for the setup or repair of a =
DTS system. The items within this section are as follows:

57029

Helm Setup allows the user to configure a helm to make the control system fully operational. By following the helm setup
wizard, the module ID is set as part of the process.
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Current Configuration: This tab displays the current
helm configuration status of the vessel. The information is

presented in a matrix format that is configured in a manner .

that displays information relative to the back of a boat.
Example: starboard on the right and port on the left. Some
of the information provided in a matrix is the module's city
ID, software version, and quantity of modules at that
address.

Assign City ID: This tab allows the user to set the City
ID's for each helm module. This is exercised by moving a
handle that coincides with a module. By following this
wizard, the module’s City ID is set.

Lever Adapt: This tab allows the user to configure the

LD B3 Reguraed N & e 1L -~ N

[ T e

Port Cars kg P Inside: Etartoand bl ‘Biartioard Guiside
T Tl W o
il o A
Helm 1 e Buch Lmus b-xcom L= Gl ackons
L LT o FER ATl
] ot L)
Hedm 2
Helm 3
|
i' Helmd

[
57030

= L - Reamred a1 Gl 1L = EN
Ml Toch sk

l \ry Pioms v eneves wll Larure on all Hulmo G the Beutrel duten pusition, then prs duzt. @

57032

LD B4~ Reguied a5 gl 1L -~ N

lever through its range of operation so that the module can [IER

learn the positions of forward, neutral, reverse, and all
detents.

ey |
Select Helm ﬁ
|
|
Select Lever Canfiguration
Chonse Lewer Tone Chosge Shitt Relariny
S ——
armaw buttons n
Loy il et 0
. =]
rankne.
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Steering Wheel Config: This feature provides access to a
tool that allows the user to set the center location of the
steering wheel. The tool must see movement of the
steering wheel for the value to be set. For example, if the
steering wheel is already in the center position, move it left
or right and back to center to set the value.

Remote Joystick Configuration: The Remote Joystick
Configuration button provides access to a tool that allows
the user to define the number of remote joysticks available
on each helm. The number of helms will be displayed
followed by the number of remote joysticks the helm can
use and the number of joysticks that are enabled for the
helm. This does not indicate a total number of joysticks on
the vessel, but rather the number of joysticks accessible
by each individual helm.

CAN Pad Configuration: CAN Pad Configuration
provides access to Trackpad, Autopilot, and SMUX status
and configuration tools required for setup or relocation
within a SmartCraft system. The items within this section
follow:

LD B4~ Regaed s & g 191 -~ N
M Teh sk
£ Staenng Whesl Comhg
it

Select a Helm to Center Stearing Whael

i

Ering the steering wheel o center position and leave it in place.

Adapted Posltlen: 0
Actunl Fosition: 670
Requires Adapting: Trus

Press 'Save’ to begin Calibration

[ |
|
P Ao 8 @ o
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g CAN Pad Configuialios
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Trackpad Configuration: This feature allows the user to AE—— il
view and configure the trackpad on each helm. Trackpad [iE
Configuration displays the current trackpad configuration
status of all helms, as well as information related to each
trackpad. Trackpads that show in the grid with a black o
background are not configurable. esse Trackpas:
If there is more than one trackpad at a single address, the
trackpad in conflict will need to be reassigned to a new
address. To identify a trackpad at a specific location with
one in the grid, press a button on that trackpad and a cell
in the grid will flash indicating its location.

IMPORTANT: To prevent potential conflicts with another
module, this tool will not assign a trackpad to the address
of D9.

Iiksd Muraber of |rackpads nn Veasel: 1 Canfnurstie: 1

o LmE EENNEN B | el

(W] et 2 el e e

57037

Restore Defaults: This feature gives the option to assign e —— = -

Ml o finp

all trackpads to their original City ID. 3 e Dernutn

darngmiin Easige lranspumts

Restore Defaults

NOTE: Plansa maks surs
engines are not running during
canfiguration ta avaid
unexpected features belng
mngaged from a key press,

Press "Start’: Lights on the
conflgurable Trackpads will
blink except for VesselWisw

Trackpads.

L
[ @ ¥
¥ R s 8
57038
Autopilot Configuration: This displays the current SIS R A1 At il

autopilot pad configuration status of all helms, as well as
information related to each autopilot. Autopilot pads that
show in the grid with a black background are not
configurable. If there is more than one autopilot at a single
address, the autopilots in conflict will need to be
reassigned to a new address. To identify an autopilot at a
specific location with one in the grid, press a button on
that autopilot and a cell in the grid will flash indicating its
location.

fiessel Trickpads - ChM H

Inknd Mumber of |rackpade nn Veasel: 1_Canbquenbls: 1

E 1 ois EEN NS B el

(7] bR S e e et

57039
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LD B4~ Regaed s & g 191 -~ N

Assign Trackpads: This feature provides the user a
wizard for assigning autopilot pad addresses by helm. All
configurable autopilot pads on a helm will flash.

NOTE- Autopl'/otvpads on ear//'erzeus andAX/Us models Select the Helr Ehat you want to set the Autopilat treckpad Tor, @ S
may not be configurable.

NOTE: Please make sure engines are net running during
canfiguration te avaid unaxpectad fasburas baing

engaged fram a key press,

Press "Start’; Lights on the configurable autopilot
trackpada will blink.

D —-—
[ - @ ¥
o] rEREE L8
57040
SMUX Configuration: SMUX Configuration allows the e — .

user to view and configure the SMUX on each helm.
SMUX (smart multiplexing) refers to the rocker switches.
The Configuration tab displays the current SMUX Select the Helm Ehat you want to set the SMUX for. @ ﬁ
configuration status of all helms, as well as information
related to each SMUX. SMUX that show in the grid with a
black background are not configurable. If there is more
than one SMUX at a single address, the SMUX in conflict
will need to be reassigned to a new address. To identify a
SMUX at a specific location with one in the grid, press a
button on that SMUX and a cell in the grid will flash
indicating its location. The Assign SMUX tab provides the
user a wizard for assigning SMUX addresses by helm. All
configurable SMUX on a helm will flash.

MOTE: Please make sure engines are net running during
canfiguration te avaid unexpectad fasburas baing

engaged fram a key press,

Press "Start’: The AUTO light on the configurable SMUX
will blink.

g——m
F s
¥ e EEMNEN B | el

HER RLMILAY AR CINANTR MTRRT | OESW o
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Drive Configuration: Drive Configuration provides access ', = = .

(LTI

to a tool required for the setup or repair of a DTS system. [ GG

The items within this section follow:

Drive Inibalzstion

Drfve: Alig nitien

Bz iall O e g renmed

‘Jﬂﬂ.
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HER AN AR CHOTIRMTE LMALES  BHKE | (T

= k]
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Drive Initialization: Drive Initialization provides access to
a system feature that moves the drives and trim tabs
throughout their range of operation to learn the sensor
range values.

Drive Alignment: Drive Alignment provides access to a
feature that performs an on the water and under power
drive adjustments test needed to maintain a straight
heading.

LS B3~ Regared N ddgd 1L -~ N

e Lol 2
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M Tl g
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Saelect Drives to Initialize
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o
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oY

Pross "Start’ ta begin drive initialization.
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= Alsgnrmmnt

e Align Steering

Compass Configuration: Compass Configuration
provides access to any compass configuration settings
required to setup or repair a Joystick Piloting vessel. The
features within this section follow:

e

Note: This procedure is used to align the drives simultaneously
with the steering wheel. The desired result is to ensure that the
wessal tracks a straight course when the steering wheel is in the
canter positien.

Emsurs yoau are in n leeation whers vassel ean ba manusvarsd nk
Cruleireg Speed 1o complete calibration,

Ensure that the stecring wheel bs contered,

Driva alignmant not awailabla, could not communicate with one ar
more TWVMs.
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Compass Calibration: The Compass Calibration Wizard will walk you through all the steps necessary to configure and
validate the compass for use by the autopilot systems. This is the recommended path for completing the compass
configuration process.

Compass Orientation: The Compass Orientation step . . R —.--
allows you to define how the IMU is physically mounted {3 compmen Grmntateon
with respect to the bow of the vessel. Compass [nstallation Orientation

Flease select campass orlentation then press et

57047
Compass Linearization: The Compass Linearization step ', . .. ST

£ Compmsm Linaanzskon

will adjust the compass for your region's magnetic L. re— [
deviation. Compase Lincarization Stap 1of 2

You are entering compass linearizatlon, Ensure vessel
ixin a location where calibration running maneurers can
be performed. {Calibration is not required on basic
boats)

57048
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Clear Compass Compensation: The Clear Compass
Compensation step clears the heading error
compensation table that is created and used by the
autopilot to arbitrate headings between the IMU and GPS.

Auto Heading Offset: Auto Heading Offset uses the GPS
to automatically adjust the compass based on how well
the compass is pointed towards the bow of the boat.

Manual Heading Offset: This feature allows you to
manually enter a known heading by referencing another
source (external to the boat) which will adjust for how
accurate the compass is pointed towards the bow of the
boat.

[ DS G3 - Registered has 44 days left. - o IEN
File  Tools  Help Sterndrive - 6 Cylinder Axius 4.3 - BRZ14_PV_AEA - Helms 1 Engines 2
7{1 Clear Compass Compensation Close X'

Clear Autopilot Compass Compensation

Press Next to clear the il ion table.

[ rElle & f
m v [T mou  owamao OMGOSK  RRAM UTBWWE
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Validate Compass Configuration: The Validate
Compass Configuration step validates your current
compass to ensure it will work properly with the autopilot
features.

Merc TDS Reset: The Merc TDS Reset configuration is
used to pair key fobs to the Merc TDS (Theft Deterrent
System) or remove the Merc TDS.

LS B3~ Regured T el 1L -~ N
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Personality

VO - eI i, =

Personality (referred to as Import in previous versions of ', .. .. ST e
CDS G3) allows access to a function for importing a vessel
specific file into a boat that contains calibrated parameters.
(Example: boat length, center of gravity, or reverse drive
efficiency.)

This screen also provides the ability to import and export
gauge settings. These files are created by an OEM

engineer. This feature applies to a Joystick Piloting m

e A k@ B B ¢4 ©
m [T R = Rt s .
57054
Diagnostics
Diagnostics allows access to diagnostic functions that B — T T —

enable the user to perform operations like injector test,
spark test, setting engine location, cylinder misfire test,
etc. These tests are initiated by CDS G3, but are
controlled by the ECM/PCM.

) G
e ——————— )
IR : m
W‘l g :
url Pu i
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Set Trim Limit: This feature allows adjustment of the
upper limit the drive can travel while under power.
Because this is a configuration feature, and not a test, this
procedure will eventually be moved to the Configuration
section.

L0 - R ed i & g 191 -~ N
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Set Tilt Limit: This feature allows the user to set the e e —— .

maximum tilt up location from an ERC. Set Tilt Limit is
controlled through the ECM and is only active at low RPM
and when the engine or drive receives a trim request from
the ERC. Setting a lower value than factory default is
useful if there is an obstruction that would cause damage
to an engine, drive, or boat component while trimming.
Because this is a configuration feature, and not a test, this
procedure will eventually be moved to the Configuration
section.
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Set Engine Location: This feature allows the user to view - OO e [ g Y =N
] Swi Enginm Locattza

ke

or change the current engine location. Changing the
engine location is necessary when setting up a
multiengine boat. Because this is a configuration feature,
and not a test, this procedure will eventually be moved to
the Configuration section.
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LD B3 R ed s 5 e 1L -~ N

Set Tach Link: This feature allows the user to configure '~ Il Eb
the signal coming from the gray engine harness I i e

tachometer lead. This drives either an Analog Gauge e

Interface (AGI) or an SC100 System Link gauge.

When Tach Link is enabled the gray tachometer lead does [6.CRaE(y R S P mdlicieore Erl\aadcal

not output the analog tach signal. Instead, the PCM sends Pt Ak =

a digital signal that can be received by the Analog Gauge
Interface (AGI) or SC100 System Link gauges, if the
proper adapter harnesses are connected.

To turn the Tach Link function OFF, select Disable. The
gray engine harness tach lead once again outputs an
analog tach signal. Tach Link only appears as an Active
Test menu option if the function is supported by the
selected engine's processor. Because this is a
configuration feature, and not a test, this procedure will
eventually be moved to the configuration section.

Rwiad Enginee » H i eegivs o sotchiphneed by the sngara e on O nd diciodsedangean.

B CAMCEL CONFGURATION

= -
57060
Cylinder Misfire: This test allows the user to isolate a  — R —————————

problem for a particular cylinder. Select a cylinder and e S
start the test to diagnose the engine; watch and listen for a

C . . . STEP 1 2 3 4
reaction in the running of the engine to occur. No reaction

would indicate a possible issue on that cylinder. CYLINDER MISF FE TEST DESCHIFTION
NOTE: On FourStroke, large horsepower engines it may PURPOSE: To corfim pragar wpseation of ssgine crlindars
be difficult to detect any noticeable RPM or sound changes RESULT: P aselst It <erifying 2 maturcticring cyincer
When the m18fll‘e test IS done af /d/e. /an ObVIOUS Change ENGINE STATE: Key OM all enpires, During tus beak, b sngine will be requined bo starl.

/s noticed, try fo test again at another throttle position
greater than zero percent or under load.

& EXTTEST MEXT 3
| nE B ER A
57063
Fuel Pump Output: This test allows the user to test the B —_— B ————————

fuel pump for mechanical activity. The test will not function
if the engine is running.

STEF 1 2 3 4

Tnfing Frue sbarbrard wniire. |ishen for bh Sl pursp o aciusbs,

Bl Brnz n_': o START

& CAMCELTEST

H

i»
B
=
@
Wz
.
e
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I KL - P g 47 e -~ N
Bk Mook Hals Cuskoard - 4 Oglinder - BOALLAA - Engines 1

STEP 7 2 3 4

Testing the starhoard znpinz. Ustes f2 sudibie debastion of the veive

Idle Air Control: This feature allows the user to test the

functionality of the idle air control valve. The behavior of

this test on a running engine will depend on the engine

coolant temperature and idle control calibration in the 64* pomEEm
ECM. Once the engine has reached its normal operating i
temperature the running test will allow you to apply a

positive or negative offset to the base IAC set point. As

you decrease the offset with a negative value the engine

RPM should decrease. The engine idle control strategies

may prevent you from exceeding allowable set points.

el il s i L 384,

£ CAMCELTEST FINGH TEST O
T EEEEEEE 00
57304
Horn Output: This feature allows the user to test the horn. ; —r ey = -

ez, Thck Trsiir g - Mibaard - 4 Cyinder - TheltiepARS - Engines 1

Listen for the horn to sound during this test.

HORN QUTPUT

Salee n hars man.

Spatecard STAHT 3
Racued Eagivwts = 1 i e=gine i 2ot dpliveed, boythe anglira e mar O sadecirgdced ang ran
& EXTTEET
o % B @ A
57064
Ignition Spark: This test confirms the existence and - . i
strength of the spark. il B hlntemit

STEF 1 2 3 4 5

Tams Ir Frogre . Teatlng g silen calldcy bder 184 o0 i markaard argine.

Dioerve the sparcamaseche spen gap.

Lo s e ey B et S
A P T YT T S T
! Morguice wurly Ay eefubing FIAEH 125

& CAMCELTEST FNISHTEST &
" EEEEIZE
57066
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Smart Start: This feature allows the test of the Smart Start "

M b ek

system and allows the user to start and stop the engine 5 martbtar

LS B3~ Regured i (el 1L -~ N
Seermdrive - ECT & Culireler Brava - BAZ14_PY_ADZ - Frgines 1

from the CDS G3 program.

STEF 1 2 3 4 5

Testin prograss

Enginz Famning

14* m

ke

& CAMCELTEST

AMISHTEST &

v EEEEsETE

Tach Output: Used to validate that an analog gauge is
calibrated properly and the ECU is driving the analog
signal.

Mia Tzl sk

STEP 1 2 3

Tast b progeess

57068

L0 - R el N & Ol 1L -~ N
Tamtirg - Outhanrd - 4 Cylinder - TheRDinpARS - Ergines 1

#llanalog Echomedee gauges should bedisplning 3002 B

40" mumm

& CAMCELTEST

e o
s worty by e g VT TEST

U wEe

RRISHTEST &3

v EEEEsTE

Steering Override: This test is used on Axius engines
only and allows you to override the TVM drive position on [EREEEET

57067

LD B3~ Regured a1 dded 1L -~ N
Sherralrive - daium 4.2 - MYI0pSAAT - Haime 1 Frgines 2

an Axius Gen | or Axius Gen Il system.
You can set the drive position via a slider or select auto to

STEF 1 2 3 4 5

begin a sine wave sequence for a short period of time. For SHictesptisneorine s,

Axius Gen I, the engine must be running to change the e i
drive position. Axius Gen |l systems have the option to Frabine
override the drive position while the engine is not running.

& CAMCELTEST

Farieg. o

paimnge | secor:rn

T O

57070
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Injector Pulse: This test confirms if an injector is actuating "/, . T T

while installed in the engine. T

STEF 1 2 3 4 5

T In Frogram, Tating Injssvar 1 Br e marbaand argiea,

2
& CAMCELTEST
v HEEESEEE @
57072
. H H : L% 3 Reges e - N
.Auto. Tgst. This selection performs a §er|es of tests to g T R T
identify if any faults are generated. This test also R R
energizes the ignition system to generate a spark as a TS o
starting point for diagnostics.
Testir Progress Testngithe starzcard sagine,
Testiog i igiion ook anelimder |
L
& CAMCELTEST
H L
57071
Reflash
r CDS G3 - Registered has 45 days left - olEW
ReﬂaSh a"OWS a user to reprogram Contr0| File Tools Help Sterndrive - EgCT DTS 6 Oilinder Bravo - BRZ14_PV_AEA - Helms 1 Engines 1
modules. % Reflash

*  Module Reflash: This feature will take you
into a guided process for reprogramming
modules.

* History: This will allow the user to view all
previously performed reflash events. e

Module Reflash

T —
History

4

f o g &N @

MODULEDATA wow  concummon EETSTSUSN  Reruasn UTERATURE

57074
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Reflash Package Browser—-Show All: The
browser displays a list of available reflash
upgrades. The page file consists of specific
modules that are allowed to be upgraded. The
page also gives the user a wide variety of
methods to sort and search the list of package
files (e.g. date, category, service bulletin, etc.).
When Show All is selected you will be shown the
other selectable status, Show Filtered.

Reflash Package Browser—Show Filtered:
When Show Filtered is selected, you will only be
presented with reflash packages available for
detected modules.

Reflash Package Browser-No Updates: If the
modules detected have no reflash packages
available, a notification is presented stating this.
This is only available in the filtered view.

File Tools Help

# Reflash Package Browser

Group By

v Axius Gen1
) Axius Gen I
~) DIESEL

Search Text

Date Range

| Enter Search Text

‘ ‘ From date H To date ‘ Show Filtered )

Nam-~ Category Date Released Comments Service Bulletin Number

i
3
10

~) DIESEL TDI
) DTS Command Module 1

v Family I

j

I

~) Joystick Piloting Outboard 1
~) MerCruiser 78
~) Outboard 8
~) Racing 1
2 &
P f R g & #
[H] e e
57076
e 5 - Pegiined M43 Qi oL - " N
i Twstirg = Quibaard - 4 Cylnder - TheftDinpAES - Engines 1
tnsh PRckags [rowssr L done |

. -
Erber Saarch Text | | From dace |-| T2 dabe

v Fibered |

Camrapra Grruis Aulkan Harshor

= e At}
= oemm O L]
i1 0TS Coraraznd Moduls 1

Aamly 1 T
) deymkk il Sualseend 1
[ F
i Qurhaard 1
i amng ]

078 123 - Fegurzined M S Ol 1L

Sham Al

These ase o eeBash packages avadabke b upgrade e commeslod enine o el sysbem
Stk “Shrwe BIF obmve 4 wowsewr the st ofinstalled pechages.
Al vy it ot b cam b b 3wsibabile oo
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Section 5 - Becoming Familiar with the CDS G3 Program

0% 55~ Rigeraed has 45 diy? 191 - » EN

Reflash Prerequisites: These indicates the B — -~
requirements that must be met for reflash to
proceed. If you receive green check marks the

Saend Foccsge 190F " riche sk
Lapeep

requirements have been met. A red X indicates T =
the prerequisite has not been met. A yellow i e b 13 «
exclamation point identifies a caution status. e e %
For details on each prerequisite, see the L s s “

dedicated page under reflash in the help menu.

{

PTG e B 116

Eyenrt b ny L3
e
e
i
- ¥ Lobalach i 1 L
...,r_*
P
H
57075
Reflash Module View: This view will show you — B ————
the modules available from the selected reflash
package. If the module is upgradeable this will be e e
indicated by a lightning bolt icon. The topmost I ~
upgradeable module will be highlighted indicating s rosan 2330 S
the order in which to reflash. Up-to-date modules s — o =
will be indicated by a green check icon. Modules T 6 Bt %
that are in the package but that may have a wrong s e — >
calibration ID, or missing information, will be e P ¥
indicated by a slashed circle icon. Modules that F .
are conflicted (for example, more than one module v
on the same city ID) will be indicated by a red R .
icon.
NOTE: Multiple engine/helm configurations may
require a certain engine fo be keyed off.
wear
P
H
57079

Reflash—Serial Number/Hull ID: This allows the user to input the information into CDS G3 for record keeping.

Reflash Cautions: This page warns you to be careful when reflashing. It is important to make sure you disconnect all
SmartCraft gauges, including VesselView, prior to reflashing.

Reflash Progress: This page allows the user to monitor the progress of the reflash event. After a successful reflash, helm
adaptation or set engine location may be required as determined by the package file. Perform the required steps and click
close to be redirected to finalize the reflash session.

Show Options
These settings are accessed from the upper text menu by choosing Options.

Show Options allows you to setup or change certain behaviors of the software. For instance, you could change the save
location of the Print Screen function.

CAN Hardware Settings: This menu allows the user to configure the SmartCraft Diagnostic Interface.
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Data Record: The Data Record settings allow you to
change the location the application will place a recorded
file and the CSV export file. L

Reflash History Directory:This menu allows you to view Uit s o T e
and change the reflash history output directory where

[P wnils  Comnmmdions  Laegusge

b
e
wed

R PIPRGH Gt Bk © Moozt b Do oomanis 4
reflash reports will be saved.
Screenshots: This menu allows you to configure the print pcetenioae E—,
. . . . Bl wir Paa C:¥lzers'Fab ki Dooumenknfie £
screen settings by changing its location. =
[ETEC R LM Fub i Dooume ks e (H‘:I
Sorcenshuls
Dol Ralh T R AT e ST B ‘
NS
[save ; cancrl &) |
57080

Units: This function was released with version 1.4 Options
software. It allows the user to change the units of measure FFFEENE Units [ et ol L e
on the live data screen. You can choose from English,

metric, or custom, which allows you to customize your i .
units of measure for each of the following: temperature, @ Eugh=h O Memc O AR

speed, volume, flow rate, and pressure.
Temperature *F - Flowrake galh -

Speed mish . Pressure pi .
Volume floz -

Set Unit of Measure

(=) Legend
¢ = Celsiug “F = Fahrenhalt
km/h = Kllometers per hour mph = Miles per hour
kn = Knots Fl 0z = Fluld Qunces
ml = Milliliter gph = Gallons per hour
Lih = Liters per hour psi = Pounds per square inch
kP = Kilopascal inHyg = Inch of meroury
Gn\n' .:'B (CANCII l@j
57082
Cor_mectlons: This menu.alloyvs the user to enter proxy
settings that may be required in order to access the [
internet in a managed network. i
Usemame
NOTE: For most dealerships proxy settings will not be i .
used. Only enter information your network administrator Ao sk )

provides. Entering incorrect information will prevent
registration and updates from functioning.

e 91 |sanEn [~
57084
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Language: This screen allows the selection of foreign

languages. It also allows you to set the Data List
descriptions from standard to engineering terms.

Options
General Units Connections RELITEDE

Solect Language Englizh (U5 -

Cestina
Data List Setlings —_—

Mederlands

Standard Name English [UL5)
Suomi

Engineering Name
Deutsch
Ehhrvica

Bahasa Indonesia
Italiana

B#E

ey

Polski

Partugués (Brasil)
Portugués (Portugal)

Pycokmn

rancer (§j)

57085

Help Screen: The Help feature has been removed and the contents are now integrated into the user’'s manual. The user’'s
manual is available in the Windows Start Menu, in the folder named Mercury Marine. The User’'s Manual can also be
accessed through the new literature feature. More information is available under the literature feature in this document.

Literature

To open literature, select the literature icon on the bottom right of the CDS G3 program, and a new interface will be launched.

When inside of the service literature feature, various service manuals will be selectable for use. Version 1.7 will have more
literature available as the service literature is updated to be compatible with this new platform.

When new literature becomes available, it will be displayed as available for download from the Library. In a later release of 1.7,
service bulletins will also be provided and available through the Library.

Additional functions inside the literature feature include:

1. Create bookmarks to frequently used sections
2. Create your own mark ups, edits, and notes
3. Search within the service manual

Cytinder Bock/Crankcase Specificanions o

e BT L e g P i

60505
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Notes:
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Mercury University
Mercury University provides comprehensive E-Skills and Instructor-led training with CDS G3.

E-Skill Courses:
+ CDS G3 Software, Menus and Navigation
+ CDS G3 Covering 40-60 HP EFI FourStroke
»  MerCruiser Catalyst Troubleshooting

Instructor-Led Training Courses:
* Intro to CDS
+  FourStroke
+  FourStroke Advanced Troubleshooting
+  Catalyst Advanced Troubleshooting
Sign up for courses at www.mercuryuniversity.com.
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FAQs

Q: | am entering my dealer number and license key correctly to register but | receive an error stating "Invalid Dealer."
A: CDS G3 requires your full dealer number and license key. Verify you are entering these correctly.

Q: Is CDS G3 Windows 7 compatible?

A: Yes, since version 1.2. Compatibility is limited to Windows 7 Service Pack 1 Professional, Ultimate, or Enterprise. Windows
has other versions, most commonly Windows 7 Home Premium, which is not compatible with CDS G3. You may be able to
update noncompatible versions of Windows 7. Refer to Microsoft Windows Anytime Upgrade for details. http:/
windows.microsoft.com/en-US/windows/shop/windows-anytime-upgrade

Q: Is CDS G3 compatible with Windows 8.1 Professional?

A: CDS G3 version 1.5 and newer is compatible with Windows 8.1 Professional.

Q: Is CDS G3 compatible with Windows 10 Pro?

A: CDS G3 version 1.7 and newer is compatible with Windows 10 Pro.

Q: Is CDS G3 compatible with 64-bit operating systems?

A: Yes, version 1.2 was compatible but contained a bug which prevented the software from updating. This issue was corrected
in version 1.4. All versions from 1.4 forward are fully compatible with 64-bit operating systems.

Q: Will CDS G3 work with Verado?

A: At this time, CDS G3 will work with Joystick Piloting for Outboards, including Verado. Older versions of Verado require CDS.

Q: What should | put in the proxy settings in options/connections? Do not put anything in these fields unless specified by
your network administrator. In most cases, a proxy is not used. If these fields are filled in incorrectly, communication to Mercury
Marine servers for registration and updates will fail.
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SmartCraft Interface Driver Installation

In versions prior to 1.4, we have noticed a high number of issues with the SmartCraft interface cable not working after a new
installation. In version 1.4, we have addressed several issues to improve this process. If you experience a suspected driver
issue, the key indicator is the green power LED on the SmartCraft interface cable is flashing. This likely means the driver is not
associating with the hardware. Reference the following manual driver installation instructions. If the LED is a solid color, reboot
your PC and try again.

Manual Driver Installation
To begin, make sure your SmartCraft interface is unplugged and CDS G3 is closed. Plug in the SmartCraft interface and watch
the lower right corner for a new hardware found notification. Click on this notification to open the New Hardware Wizard.
When asked if Windows can connect to Windows Update, select No, not at this time. The driver was already installed with
CDS G3. On the next screen, select Install the Software Automatically. When finished, confirm the green power LED on the
SmartCraft interface is no longer flashing. A reboot may be required.

Repeat this process for each USB port on your PC.
Error Codes

Please go to service.mercurymarine.com/g3/support/g3-error-codes to see the latest list of error codes that may be displayed in
CDS G3.
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